


Go for Windows

WINGO is a Microsoft Windows (tm) program to record and display game records for the oriental game of go.

Go is an ancient oriental strategy game based on the capturing of territory.    The players alternate putting stones on 
the board, trying to surround as many empty intersections as possible. 

WINGO allows viewing and creating    of Smart-Go (tm) game tree files compatible with many other programs 
including Smart-Go (Macintosh) and Mgt (UNIX & MS-DOS). These programs and a large collection of Smart-Go 
files, including games, tutorials and problems is available by anonymous ftp from ftp.u.washington.edu. 
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The Game of Go

Go is a two player strategy board game.    Players take turns putting black and white pieces (called stones) on a 
board.    Stones are placed on the intersection of the lines on the board, and can be placed on the edge or in the 
corner.    Go is generally played on a 19 x 19 board, but smaller boards such as 9 x 9 or 13 x 13 are used by 
beginners or for shorter games.

Rules

1. The board is empty at the beginning of the games.

2. Black makes the first move, after which White and Black alternate.

3. A move consists of placing one stone on an empty intersection on the board.

4. A player may pass at any time.

5. A liberty is an empty space adjacent to a stone or solidly connected group of stones. A group of stones is captured 
and removed from the board if it has no liberties.

Liberties:  A stone in the centre of the board (Dia. 1.1) has 4 liberties.
  A stone on the edge of the board (Dia. 1.2) has 3 liberties.
  A stone in a corner of the board (Dia. 1.3) has 2 liberties.



Capturing:  A stone or group with only one liberty (Dia. 2.1) is said to be in atari (or ate).
  White captures the stone by occupying its last liberty with 1 in Dia. 2.2.
  This stone is then removed from the board (Dia. 2.3).

Similarly on the edge of the board:

A solidly group of stones may be captured as foolows:



The five white stones in Dia. 4.1 can be captured if Black plays at 'a', resulting in Dia 4.2.
Self capture is illegal, however, so White may not play at 'a'. Capturing enemy stones happens before self capture, so
Black 'a' is a legal move if it captures the surrounding White stones. Black may not play 'a' if White has other 
liberties, because then the Black 'a' would be suicide (Dia 4.3).

6. No former board position may be recreated (to prevent loops).

The simplest example of this rule (called a ko) is the following:

By the ko rule, black cannot play the marked move in Dia. 5.3 because it would recreate Dia 5.1. Black must play 
somewhere else on the board before taking back the ko. In this situation, Black will often play a move which 
requires a response from White. Such moves are called ko threats.

7. The game ends when one player resigns or after two consecutive passes.

8. At the end of the game, any stones which cannot avoid capture are removed as prisoners without actually being 
surrounded.



9. A player's score is the number of vacant points surrounded by his/her stones minus the number of prisoners he/she
has lost. The player with the higher score wins.

For further information, see the file RULES.MGT.



Books on Go

This is a list of Go-related books, periodicals, and mail-order sources which has evolved since its humble beginnings
in 1985.    New entries, or additional comments on current entries, should be sent to the addresses listed for Neal 
Gafter; please be sure to let me know your playing strength.

First, though, some recommended readings for beginners:

Go Books for Beginners

My recommendations for a new player are, in order:

For really new beginners, play a handful of games on a 9x9 board with a regular "club" player.    You should get a 
handicap of somewhere between four and none stones.    Don't worry about winning or losing, and don't take too 
much time with any of your moves.      Unlike chess clubs, you will find go players usually eager to help teach a new
person.    Playing short games will give you a fundamental feel for the game that you can build on.    You should also 
play at least occasionally during your book studies, preferably with a stronger player.    Try to understand your 
opponent's moves.

Go for Beginners, which can be found in some mass-market bookstores, is fairly good for a first book.    The Second 
Book of Go is also good and fun.

Nothing is better for bringing beginners up to speed than problems. For this purpose, I would recommend Graded 
Go Problems for Beginners.    You will probably want all four volumes, but if you decide to get fewer, get the higher 
numbered volumes.

A good set of books to own is the Elementary Go Series, comprised of (in order that you should get them): In the 
Beginning, Tesuji, 38 Basic Joseki, Life and Death, Handicap Go, Attack and Defense, and The Endgame.

Lessons in the Fundamentals of Go is fairly easy to digest, and I think you will learn something from it each time 
you read it.    It should not be your only book, though.

Strategic Concepts of Go and Basic Techniques of Go are good but a little difficult to read for the beginner.

If you want some cultural background and fun anecdotes about the game, try The Treasure Chest Enigma.

GO Books, Periodicals, and Mail-order sources

This is a list of Go-related books, periodicals, and mail-order sources which has evolved since its humble beginnings
in 1985.    New entries, or additional comments on current entries, should be sent to the addresses listed for Neal 
Gafter; please be sure to let me know your playing strength.

By the way, you should check your local Go club to see if they carry books.    Sometimes the distributors will give 
them good discounts.    I [HL] got my copy of Invincible for $50 from the S.F. Go Club, a savings of $20!    Second, 
Ishi Press visits each Go Congress, and there are usually lots of special prices.    For those near stores listed at the 
end of this message, you can go right to the store or distributor. If all else fails, you can order by mail.

This list may be freely distributed, so long as the information concerning the contributors and this comment remain 
with the list.    A current copy of the list can be obtained by sending a SASE to the address listed for Neal Gafter, or 
by electronic mail.



Every entry which is available from Ishi Press is listed with its mail-order price.    The format for entries begins with 
the catalog number, then the price from the catalog, the title, the author in parentheses, then paragraphs of comments
with the initials of the contributor in square brackets.    See the appendix for a list of contributors.

This version created Mon Oct 7, 1991

The Books

G1  $13.00  Modern Joseki and Fuseki I (Sakata)
G3  $13.00  Modern Joseki and Fuseki II (Sakata)
These books cover in detail a few representative games and analyze the fuseki and the results of using possible 
joseki.    It is an analysis of classical even game fuseki.    Book I covers "Parallel Fuseki" where black and white 
occupy opposite sides of the board; Book II covers "Diagonal Fuseki," and the "Shusaku fuseki".    These books 
contain an extensive collection of Joseki.    It is easy to get lost in detail in these books, but they are the most 
comprehensive works on the subject.    G5 continues where these    books leave off. [NG] Excellent for 8 kyu or 
stronger. [BGC]
These are currently out of print.

G2  $9.95  Basic Techniques of GO (Haruyama and Nagahara)
This is the companion volume to G6.    It is a brief (but detailed) survey of tesuji, even game and handicap fuseki, 
and yose.    It is sometimes easy for a beginner to get lost in detail here, but these books are definitely of value. [NG]
A very good book for learning techniques when you get so far that you know the rules thoroughly. Especially useful 
for handicap games. Highly recommended. [OL] This book has depth, and is a good way for 1 to 8 kyu players to 
get to shodan. [BGC]

G5  $13.00  The Middle Game of GO (Sakata)
This book covers some of the standard techniques of the "chubansen", or middle game.    It does this by analyzing 
continuations of some games discussed in G1 & G3. [NG] Excellent. [BGC] Currently out of print.

G6  $12.95  Strategic Concepts of GO (Nagahara)
This book is an introduction to the eight major strategic concepts of Go: Miai (two moves such that if one player 
occupies one, the other player must occupy the other); Aji (the latent possibility of a sequence or sequences of play);
Kikashi (forcing move); Thickness; Korigatachi (overconcentration); Sabaki (light play); Furikawari (exchange); 
and Yosu-miru (probe) These concepts are illustrated with specific examples and with actual game records.    An 
excellent book. [NG] Excellent for 6 kyu or stronger. [BGC]

The following seven books comprise the Ishi Press Elementary Go Series. They have all improved my game. Mike 
Meyer <mwm@Berkeley.edu>

G10  $12.95  In the Beginning (Ishigure)
An excellent beginners book describing techniques of the Fuseki.    This book does not stay on the shelf much. [NG] 
An excellent work on fuseki (opening) for even game. Highly recommended. [OL] An excellent introduction to 
fuseki. [BGC]

G11  $13.95  38 Basic Joseki (Kosugi and Davies)
An excellent introduction to Joseki. [BGC]

G12  $12.95  Tesuji (Davies)
An excellent book by a western writer covering many basic tesuji.    This book is easy to read, though the problems 
are not always easy (for me).    Of course, the stress is on tactical reading. [NG] A very thorough approach to the 
concept and techniques of tesujis. Warmly recommended. [OL] Excellent. [BGC]

G13  $12.95  Life and Death (Davies)
An excellent book covering basic shapes arising in life-and-death situations.    Many problems.    An excellent book. 
[NG], [BGC]



G14  $13.95  Attack and Defense (Ishida and Davies)
A well organized survey of basic middle game techniques.    Another excellent book. [NG] A very good book when 
you need to get familiar with the standard techniques of attacking and defending (hence the name... :-) in the middle 
game. Highly recommended. [OL] Will improve anyone's fighting style. [BGC]

G15  $12.95  The Endgame (Ogawa and Davies)
The endgame is the final, and therefore decisive part of the game.    This is an excellent book teaching about the 
techniques of the endgame. [NG], [BGC]

G16  $12.95  Handicap GO (Nagahara, Bozulich)
A good book describing the strategy for high handicap games, both from white's and black's point of view. [NG], 
[BGC]

G17  $10.95  Kage's secret chronicles of Handicap GO (Kageyama)
Good book - useful but not great. [BGC]

G18  $12.95  Test your GO strength.

G19  $14.95  The Breakthrough to Shodan (Naoki Miyamoto, 9-dan, trans. by Jas. Davies)
Excellent book. [BGC] Can get the strong kyu player out of the rut he's in, opening his eyes to *new* aspects of the 
game. [BA]

G21-3  $22.95 ea  Dictionary of Basic Joseki Volumes I, II, III
This is the most comprehensive work in English on Joseki.    It is in dictionary format, and is easy to follow. 
[NG] ...containins MANY common trick wariations. Warmly recommended. [OL] Necessary for any Go library. 
[BGC]

G21  $22.95  Dictionary of Basic Joseki I
the 3-4 point, the small knight approach., the large knight approach, the two-space high approach.

G22  $22.95  Dictionary of Basic Joseki II
the 3-4 point, the one space high approach, the 5-3 point, the 3-4 approach,    the 4-5 approach, entering at the 3-3 
point.

G23  $22.95  Dictionary of Basic Joseki III
the 5-4 point, the 3-4 approach, entering at the 3-3 point, the Star Point, the small knight approach, the one space 
high approach, the two space high approach, positions with no approach move, the 3-3 point, the shoulder hit, the 
large knight approach.

G24  $10.00  Enclosure Joseki (Takemiya)
Standard sequences for invading and living in enemy enclosures.    Necessary for any dan. [BGC]
Currently out of print.

G25  $12.95  Appreciating Famous Games (Ohira)
A detailed commentary of some famous games. Fun and instructive. [BGC]

G26  $10.00  The Direction of Play (Kajiwara)
Excellent book. It will improve your intuition. [BGC]
Currently out of print.

G27  $12.95  Kato's Attack and Kill (Kato)
Techniques for chasing weak enemy groups to gain advantage. Excellent book. It will make you dangerous. [BGC]

G28  $12.95  Lessons in the Fundamentals of GO (Kageyama)



A good book covering some of the fundamentals, but necessarily briefly.    Ladders and Nets; Cutting and 
Connecting; Walking ("ordinary" moves); The struggle to get ahead (running and pushing battles); Territory and 
Influence; Life and Death; How to study Joseki; Good and Bad Shape; Proper and Improper moves; Tesuji; the 
Endgame. [NG] Great book for 1 to 8 kyu. [BGC]

G29  $10.95  Reducing Territorial Frameworks (Shuko Fujisawa)
Presents techniques for reducing and invading the opponent's territory in the middle game, with emphasis on 
reduction. [NG]
Currently out of print.

G30  $3.95  An Introduction to GO (Davies and Bozulich)
"A simple and clear introduction to the game of GO based on the Japanese rules.    Tactics and strategy as well as 
example games." [Ishi flyer]

G31  $6.95  The Second Book of Go (Richard Bozulich)
"..takes the reader who has learned the rules and rudiments of strategy and introduces them to the ideas required to 
get to the 12 kyu level... covered at a level that can be grasped by the novice" [Ishi flyer]

G32  $12.95  The Power of the Star Point (Takagawa Shukaku)
An excellent book covering the fuseki resulting from a san-ren-sei, or three star points in a row. Although the book 
focuses on even game fuseki, it would be especially useful for those playing low handicap games. [NG]

G33  $10.95  The Chinese Opening: The Sure Win Strategy (Kato)
"The Chinese opening in GO is the newest ... yet within two decades it has established itself as one of the most 
popular.    In one pattern it combines both influence and territory.    It is a dynamic and flexible opening that fits well 
with a variety of playing styles... In tournament GO, it enjoys the best winning percentage for black of any opening."
[Ishi flyer]

G34  $12.95  All About Thickness (Ishida Yoshio)
"2-color diagrams make the advanced concepts of thickness and influence instantly clear.    How to build thickness 
and how to use it to attack or to make territory.    Large diagrams and simple explanations are clear to everyone from 
novice to dan-level players." [Ishi Flyer]

G40   The World of GO (edited by Richard Bozulich)
"Here is a reference on just about everything having to do with your favorite game.    There is history and 
philosophy, a who's who of current and historical players, a complete glossary of GO terms, a directory of GO 
tournaments, computer GO, complete Chinese and Japanese rules, information on playing equipment and more.    
Hardbound."    [Ishi Flyer]

G41  $7.95  The Magic of GO (Cho Chikun)
"A unique introduction to the game and culture of GO. This book's step-by-step approach takes the reader from the 
most basic rules to playing his or her own games.    All of the fundamentals are covered in detail. Also includes 
essays scattered through the book introducing the world of GO - history, tournaments, computer GO, playing 
equipment, and more."    [Ishi flyer]

G44  $12.95  The 3-3 Point, Modern Opening Strategy (Cho Chikun)
"Today in professional GO, more and more openings are being played that emphasize tight territorial control. In both
cases, the 3-3 point if crucial, whether played to secure or destroy territory.    This book shows you 3-3 josekis in 
relation to the whole board, then delves into parallel and diagonal fusekis.    A chapter of problems will challenge 
your understanding of the concepts discussed.    Examples are drawn from approximately 100 of Cho's own games." 
[Ishi Flyer]

G45  $12.95  Positional Judgement (Cho Chikun)
"An accurate assessment of the board position during the middle game is key to deciding your play strategy. To 
become an expert GO player, you must develop positional judgement.    This book provides the first comprehensive 



treatment of this subject in English." [Ishi flyer]

 $9.95  The Theory and Practice of GO (Korschelt)
This is the first book I got on the subject; it it a translation from the original German 18??.    It was the first book on 
GO written in a western language.    I would not recommend it. [NG] Recommended for 6 kyu and stronger, as an 
unsurpassed source of problems. Also has some classic games. [BGC]

 $6.25  The Game of GO (Smith)
Do not recommend. [BGC]

 $6.95  Steppingstones to GO (Kishikawa)
Do not recommend. [BGC]

 $4.50  GO and Go-Moku (Lasker)
Lasker is a Chess whiz; this book is an ok introduction to the game. [NG] Not nearly as good as lwamoto. [BGC] 
Recommended for historical interest    only. [BA]

 $5.95  Go for Beginners (Iwamoto Kaoru, 9-dan)
This is an excellent first book on the game.    I like to keep an extra copy to give to people I think I might be able to 
get involved in the game.    At my rank it is of little value. [NG], [BGC] This is the truly immortal beginner's book. 
Useful for every kyu level - you'll learn something every time you read it. *** A must! *** [OL] You are moderately
likely to find this in the games section of a good bookstore.

G??  $10.00  The 1971 Honinbo Tournament (Iwamoto)
The game records with a detailed analysis of the games. Reviewing games of this kind is important. This is an 
excellent book for 4 kyu and stronger players. [BGC] An well-written book. Does a fine job of relating the fuseki 
and the middle-game, so that the reader can understand the result as a whole. [BA]
Currently out of print.

(Out of print)  What's your rating? (Miyamoto)
Good book - useful and fun, but not great. [BGC]

 $7.95  The Protracted Game:
  A Wei-Ch'i Interpretation of Maoist Revolutionary Strategy (Boorman)

Interesting, but not that instructive. [BGC]
(Out of print but may still be available)

 $5.95  The Master of GO (Yasunari Kawabata)
Interesting, but not that instructive. [BGC] An all time classic.    Since Kawabata (b. 1899, d. 1972) won the Nobel 
Prize in Literature in 1968, it is not usually difficult to come upon a translation of this (mine was done by 
Seidensticker for Perigee books back in 1981).    (Seidensticker also translated the Nobel Prize acceptance speech 
under the title Japan, The Beautiful, and Myself for Kodansha International Ltd. in 1981.) 
webber@athos.rutgers.edu (Bob Webber) A good novel. Not interesting as a Go-book. Seidensticker didn't 
understand Go when he translated it; help with the Go was offered him, and he refused it :-( [BA]

 $8.00  GO Proverbs (Mitchell)

H1  $69.95  Invincible, the games of Shusaku (Power)
A well commented collection of Shusaku's games.    This is a clothbound book. [NG] This book contains more than 
160 games by the Edo-period player who is recognized kisei (Go saint). About half are commented, level of 
commentary ranging from very good to truly excellent. *** !! Truly a MUST !! *** (though not before about about 
5 kyu :-) [OL] A real master in action. Fantastic. [BGC]

 $10.00  Go!
(A reprint of Takagawa's How to Play Go and The Vital Points of Go)



This book is worth buying for "Vital Points", which teaches some intuition for the fuseki. [NG], [BGC] Published by
Sabaki, which has since gone out of business.

H2  $24.95  The Treasure Chest Enigma (Nakeyama)
A delightful collection of Go anecdotes, problems, and some of Nakeyama's famous ladder problems. [NG], [BGC]

Graded Go Problems for Beginners (Kano Yoshinori)
H3  $12.95  Volume 1: Introductory Problems (30-25 kyu)
H4  $12.95  Volume 2: Elementary Problems (25-20 kyu)
H5  $12.95  Volume 3: Intermediate Problems (20-15 kyu)
H6  $12.95  Volume 4: Advanced Problems (15-10 kyu) (available soon)
Other volumes to appear as they are translated.
Excellent problems for teaching basic situations and even the rules to beginners. Very highly recommended. [OL] 
The best book for beginners to own.    The problems actually range about 5 kyu higher and lower than listed.    
[BGC]

The contributors:

[NG]  Neal Gafter.    The originator of the bibliography.    4 kyu at that time, possibly 1 kyu now.
 Reachable via e-mail as gafter@csc.ti.com, or at:
 752 Monticello Circle
 Allen, Texas    75002
 214 727-2082

[HL]  Howard A. Landman.    Reachable by email at landman

[BGC]  The Berkeley Go club, as a group. A copy of the original was passed around to the stronger players (3-6 
dan), and their comments were added to the list. The Berkeley Go club can be reached by sending e-mail to 
mwm@ucbvax.
US mail should be addressed to

 (This address is obsolete)
 Berkeley Go Club c/o Herb Doughty
 2412 Atherton St.
 Berkeley, CA 94704
 phone: (415) 548-3024

[BA]  ayers@src.dec.com (Bob Ayers)
 Bob Ayers (rma) -- 2 dan in L.A.

[OL]  olounela@cc.helsinki.fi (Olli Lounela) 3 dan.

Others are identified by full name.

Periodicals:

Go World
A slick quarterly covering professional games with in-depth commentary, tournament news, articles on strategy and 
tactics, problems, and other news.    Published by Ishi Press and available on a yearly basis.    Most back issues also 
available.
$15/1 Year  $26/2 Years  $35/3 Years

American GO Journal



The Newsmagazine of the American GO Association, also published Quarterly.    Free as part of membership in the 
AGA: $20/1 Year.    has gone up to $25, I think.    -[NG]

 The American Go Association
 Box 397
 Old Chelsea Station
 New York, New York    10113

Computer Go
A Quarterly about Computers and Go.    Go playing programs, Electronic Go boards, algorithms, tournaments, and 
so on. Back issues available.
$15/1 Year.

 Computer Go
 c/o David W. Erbach
 71 Brixford Crescent
 Winnipeg, Manitoba R2N 1E1 Canada

Kido Yearbook (in Japanese)
J1-87 $27.00  Kido Yearbook 1987
J1-88 $30.00  Kido Yearbook 1988
J1-89 $32.00  Kido Yearbook 1989

Published around May each year.    It contains most of the games from all the major Go tournaments held in Japan 
during the previous year, plus lots of biographical information (including a complete listing of all active pros, with a 
picture and brief listing of accomplishments).    Even though I cannot read Japanese, I still enjoy studying the games.
The major problem is that all the games are recorded in 1 to 2 diagrams.    Thus, some of the moves are hard to find.  
Anyway, it is a good book for strong kyu to dan players, containing *hundreds* of recent games each volume.
hwc@sigma.UUCP (Hon-wah Chan, 2 dan)

The mail order houses:

I recommend Ishi Press, the major publisher of GO Books in English and Japanese, that now has an office in the US 
where books can be ordered. Their prices are often the lowest and their service is prompt.    Once you order from 
them, you will be on their mailing list and receive monthly offerings and specials.

 Ishi Press International
 76 Bonaventura Drive
 San Jose, CA    95134 (USA)
 (408) 944 - 9900

For those of you in the Berkeley area, Games Of Berkeley carries GO books, and will take mail order.    The prices 
are generally in line with those listed here.

 Games Of Berkeley
 2010 Shattuck Avenue
 Berkeley, CA    94704
 415/540-7822

Gamescape generally has a better inventory than GOB, and will also takes orders by mail.

 Gamescape
 333 Divisadero
 San Francisco, CA    94117



 415/621-GAME

Kinokuniya book stores (SF, LA, NY) carry Go books and magazines.    They are fairly expensive (e.g. old issues of 
Go World are $6.50, whereas they are only $4.00 from Ishi Press), but they carry a lot of stuff.    One series I first 
found there, and like a lot for dan-level players, is the Gendai Igo Mei Shobu shirizu (in Japanese), see above [HL]

For those of you near Rochester, New York, there are a couple of places to get Go books and equipment.    Park 
Avenue Bookstore (370 Park Avenue; 271-6120) carries Ishi Press books, and Archimage (668 Monroe; 271-2789) 
carries both books and equipment.

pauls@inco.UUCP (Paul Stygar)
If you happen to be in Germany, you can get books from a company called "Spielbrett."    Mail order overseas has 
met with mixed success. They do have some out-of-print books in English (Modern Joseki and Fuseki I & II; 1971 
Honinbo Tournament; Go Proverbs; How to Play Go/Vital Points of Go in a volume entitled Go!)    If you want to 
try your luck, write for a copy of "spielbrett news":

 Spielbrett-Versand
 Postfach 610246
 Kortestr.10

1000 Berlin 61

Internet:  gafter@csc.ti.com (Neal Gafter)
USnail:  Texas Instruments MS 238, PO BOX 655474, Dallas, TX 75265
phone:  (214) 995 - 0696 (office)    or    (214) 727 - 2082 (home)



Definitions of Go Terms

Revised November 8, 1985, by Fletch Holmquist;
extended November 1991, by Bill Taylor.

Aji (taste): Latent threats or possibilities existing in a situation.

Ajikeshi (aji erasure): A play which removes aji.

Aji ga warui (bad aji): A position which leaves aji for the opponent to use.

Aki-san-kaku (empty triangle): Three adjacent stones forming a triangle. Generally bad shape, see gozuni.

Amarigatachi: Play where one feels he has made good moves, when in fact he has accomplished little.

Ate (Atari): An immediate threat to capture; a single liberty remains. A verbal warning is often issued when placing 
an opponent into ate.

Atekomi (aim inside): Uncertain, but seems related to a peeping move.

Atsumi (thickness): Strong formation of stones facing the center or facing along a side.
Basami: Pincer (same as hasami).
 ikken basami: 1-step pincer (on 3rd line); taka-basami (4th line)
 nikken basami: 2-step pincer (on 3rd line)
 sangen basami: 3-step pincer (on 3rd line)

Bata-bata: A tesuji connection.

-bane, -basami, -biraki: See hane, hasami, hiraki.

Boshi (hat): A capping move.

Botsugi: A connection which forms a wall of three stones.

Byo-yomi: Extra count-down time after regular clock time has elapsed.

Chosen: Eternal life; a rare position involving repetitive capture.

sen: The middle game.

Daidaigeima (very large knight's move): Four across and one vertically (or vice versa).

Dame (useless): A neutral point, territory for neither; a liberty.

Damezumari: Shortage of liberties.

Dan: Advanced grade.

Dango (dumpling shape): A solid mass of stones; a very inefficient shape.

De (go between): A move which pushes between two enemy stones.

Degiri: A sequence of two moves which push and cut.



Fukure: Swell outward.

Furikawari: Exchange (of territories).

Fuseki: The opening moves of the game where influence and territory outlines are formed. (literally: 'no stones')

Geta (clog, as the shoe): A method of capturing a enemy stone; a net trap.    The shape of the stones resembles a 
wooden clog.

Gote: Defensive play, loss of initiative. (Literally:'lower hand.)

Gote no sente: Gote move with sente potential.

Guru guru mawashi: "spinning around (into dango)". A series of attacks leading to a loose ladder and capture.

Guzumi: A good empty triangle.

Hai: Crawl.

Hamari: Fall into a trap.

Hamete: A trap.

Hana-tsuke: Nose attatchment.

Hane: A diagonal move played in contact with an enemy stone.
Hane-dashi: Outer hane.
Hane-kaeshi: Counter-hane.
Hane-komi: Hane between two stones.
Hane-tsuki: Belly attack.
Shita-hane: Hane underneath.

Hanami ko ('flower-viewing ko'): Ko where one player stands to lose a lot, but the other only a tiny amount.

Hara-tsuke: Belly attack.

Hasami (pincer play): A play that attacks by preventing the opponent's extension down either side. (see Basami).
Hasami-tsuke: Pincer attatchment.

Hazama: Balance point.
Hazama-tobi: One point diagonal jump.

Hiki: Draw back.

Hikkuri-kaeshi: Self-reversing sequence.

Hiraki: 3rd or 4th line extension.

Honte: The proper move.

Horikomi (throw-in): A single stone played as a sacrifice.

Hoshi: ('star point'): 4-4 point.



Ichi ban: A win by ten points or less.

Ichigo-masu: Carpenter's square.

Igo: An alternative name for Go.

Ikken-tobi: One point extension.

Insei: Student professional.

Ippoji: One large area.

Ishi: Stone.

Ishi-no-shita: Under the stones; a tesuji.

Ji Dori Go: Derisive term for 'ground-taking go'.

Jigo: Drawn game (by equal territory).

Jingasa: Double empty triangle (4 in a "T").

Joseki (established stones): Known sequences of moves near the corner which result in near-equal positions for 
white and black.

Jun Kan Ko: A very rare position involving repetitive capture.

Kado: Angle.

Kagame:    False eye.

Kakae: Grip.

Kakari (approach): A move that attacks a single enemy corner stone. Prevented by shimari.

Karami: Splitting.

Kata-sente: One-sided sente.

Katatsuki (shoulder hit): A play on a diagonal of the opponent's stone.

Katatsugi: A solid connection.

Kake: Press down.

Kaketsugi (hanging connection): An open connection. An example is three stones surrounding an empty point. 
Promise for eye shape, but can be attacked.

Katachi: The shape of the stones.

Sabaki: Quick development, light shape.

Karui: Single move basic to formation of flexible shape.

Omoi: Heavy, clumped shape.



Keima: Knight's move extension.
Keima-tsugi: Knight's move connection.
Keima-watari: Connection at edge of board by keima.

Keshi: Erasure.

Kikashi: A forcing forcing move, usually made outside the main flow of play.    Often answered, then ignored; to be 
used later in the game.

Kiri: Cut.

Kiri-chigae: Cross-cut.

Kiri-nobi: Cut then extend.

Ko ('eternity'): Repetitive capture.

Ko threat: Intervening move (that one hopes will force a reply) before a ko can be recaptured.

-komi:    To go into.

Komi: Score adjustment usually penalizing black    for    playing first.    Often 5.5 points.

Komoku: ('small point') 3-4 point.

Korigatachi (frozen shape): Inefficient or ugly shape.

Kosumi: A diagonal play next to one's own stone.

Kosumi-tsuke: A kosumi which is also a tsuke.

Kyu: Learner grade.

Leg: Term used by James Davies for a jogged end of a    group. Weak leg refers to a diagonal extension.

Magari (turn): A play which turns a group, forming a corner.

Mane Go: Mirror go. White playing symmetrically opposite black.

Mannen Ko: "10,000 year ko". (A special formation where whoever starts the attack must find the first ko-threat).

Me: Eye or point.
Me ari me nashi: A semeai in which one player has one eye.

Miai: Two    points    which    accomplish    the    same    result;      if deprived of one, the other must be played.

Mochi-komi: Botched invasion.

Modori: Fall back.

Moku: Same as 'me'.

Mokuhazushi ('point-detatched'): 3-5 point.



Motare: Roubabout attack.

Moyo: Large potential territory.

Mukai-komoku: Symmetrically opposite komoku played in fuseki.

Mushobu: Literally "no-win-loss". Abandoned game (due to triple ko or similar).

Nadare: Avalanche joseki.

Naka-de: Central placement.

Nakade: Unsettled eye shape.

Naka oshi gatchi: Early victory by a large margin.

Narabi: Adjacent extension from a non-contact point.

Nidan bane (double hane): Two sucessive hane plays by one player.
Nidan osae (double osae): Two sucessive blocks by one player.

Nigiri: Equivalent of coin-toss to decide who starts. One grabs a handful of stones; the other guesses odd or even.

Nihon kiin: Japanese go association.

Ni ren sei: Fuseki with two adjacent star points.

Nobi (Stretch): An extension away from an opponent's tsuke,    cross-cut, etc.
Nobi-komi: Extend into the enemy's territory.

Nozoki: A peeping move which threatens to cut.

Nuki: Capture.

Nurui: Lukewarm.

Oba: Large fuseki point.

Ogeima (large knight's move): Three across and one vertically (or vice versa).

Oiotoshi: A method of capture where stones are sacrificed to destroy the enemy's eye shape. (Literally- "robber's 
attack")

Oki: Placement. Playing on a vital spot (to kill eyes).

Onadare:    Large avalanche joseki.

Osae: A blocking move which prevents extension along a line.

Oshi: Push.
Oshi-tsubuki: Squashing move.

Oyose: Large end-game plays.

Ozaru: Monkey jump.



Pintsugi: Connect between.

Ponnuki: Space between four stones after capture.

Ryo: Double.

Sabaki: Light play; disposable stones.

Sagari: To descend straight toward the edge of the board.

San-ba-garosu: 'Three crows'. Corner enclosure by 5-3, 4-4, 3-5 points.

Sangen: Three point interval.

San ren sei: Fuseki with three adjacent star points.

San-san: 3-3 point.

Saru-suberi: Monkey jump.

Sashikomi: Insert.

Sei moku (Star points): Handicap points.

Seki: A situation where neither player may place the other in ate without placing himself in ate.    Stalemate, with no
territory awarded.

Seki-to: "Stone tower". Sacrifice of two stones at edge of board.

Semeai: Race to capture.

Sente ('upper hand'.): Threat forcing direct response, creates initiative. The    right    to    choose where to play next. 
Opposite to gote.

Shibori: Squeeze play.

Shicho: Ladder play.

Shicho-atari: Ladder breaker. A stone played in    the    path    of    a potential    shicho, threatening to make it fail.

Shimari (corner enclosure): A two-stone    corner    formation.      May    not    secure    the corner, but attacker is at a 
disadvantage.    Opposite of kakari.
 Kogeima shimari (small knight's enclosure): The 3-4 and 5-3 points.
 Ikken shimari (one-point enclosure): The 3-4 and 5-4 points.
 Ogiema shimari (large knight's enclosure): The 3-4 and 6-3 points.

Shin fuseki: A revolutionary 1930's strategy. Now blended with traditional strategy to form the modern style.

Shinogi:    Eye forming sequence.

Shita-hane: Hane underneath.
Shita-tsuke: Attatch underneath.

Soto: Outwards.



Suberi: Sliding under.

Suji: Style; skillfulness.

Susoaki: Open skirt.

Sute ishi: Sacrifice stone.

Tachi: Extension adjacent to centre.

Taisha: A joseki arising from an ignored low kakari to 4-3 point.

Takamoku: ('high point'), 4-5 point.

Take-fu: Bamboo joint.

Tasuki fuseki: Black playing the same in opposite corners.

Tedo-mari: The last valuable end-game points.

Ten gen: The centre point of the board.

Tenuki: Ignoring opponent's last move to play elsewhere.

Te okure: Wasted move.

Tesuji ('strong hand'): The best play in a local position; skillful tactical move.

Tetchu (steel post): Two stones placed in line vertically and near the edge.

Tewari diagram: Analysing by removing irrelevant stones.

Tobi: Jump.
 Tobi-dashi: Jump out.
 Tobi-komi: Jump into enemy space.
 Tobi-magari: Jump at right angle.
 Tobi-tsuke: Jumping attatchment.

Torazu San Moku: A very rare position in the corner, where either side may capture first, but would lose points to 
do so.

Tsugi: Connection.

Tsuke: Attatch. A play made in contact with an enemy stone, but not    in contact with any friendly stones.
 Tsuke-atari: Bang against (head-on).
 Tsuke-giri: Attatch then cut.
 Tsuke-kaeshi: Counter-attatch.
 Tsuke-koshi:    Attatch at keima waist.
 Tsuke-nobi: Attatch and extend (handicap joseki).

Tsume: Extension preventing an enemy extension.
Tsume-go: Life and death problems.

Tsuppari: Slap against (sideways).



Uchi: Inwards.
Uchikaki: Sacrifice on first line to make an eye false.
Uchikomi: Playing to invade enemy territory.

Uttegaeshi: Snap-back.

Warikomi: Wedge between two stones.
Wariuchi: A wedging move which has room for expansion    in    either direction.

Watari: To connect underneath.

Wei Chi: ('game of encirclement') The Chinese name for Go.

Yose: End game.
 Yose-ko: A ko of little value.

Yosu miru: Probe; to see opponent's response. May be sacrificed.

Yurumi: Loose.

Zoku-suji: False or vulgar style.



Go Proverbs

The following proverbs are discussed at length in Go Proverbs Illustrated, which is unfortunately out of print.

Six die, eight live, and four die, six live.

On the third line, four die, six live.

In the corner, five stones in a row on the third line are alive.

Six eyes in a rectangle are alive.

For rectangular six in the corner, dame is necessary.

The comb formation is alive.

For the comb formation in the corner, dame is necessary.

The carpenter's square becomes ko.

If there is no stone on the handicap point, the carpenter's square is dead.

There is death in the hane.

Strange things happen at the one-two points.

If a formation is symmetrical play at the center.

Against three in a row, play right in the center.

The enemy's key play is my own key play.

The semeai where only one player has an eye is a fight over nothing.

There are times when even a fight over nothing means something.

If there is a ko inside a semeai, capture it on the final play.

Learn the eye-stealing tesuji.

Don't make empty triangles.

Don't make compact groups of stones.

At the head of two stones in a row, play hane.

At the head of three stones in a row, play hane.

Strike at the waist of the knight's move.

Shoulder connections, hanging connections, and knight's move connections.

If your stone is capped, play the knight's move.



Beware of the clumsy double contact.

Don't play in direct contact with the opponent's stone caught in your squeeze-play.

Don't make a play adjacent to a cutting-point.

Capture what you cut off.

Never try to cut bamboo joints.

If you have on stone on the third line, add another, then abandon both of them.

Beware of going back to patch up your plays.

The monkey jump is worth eight points.

If you don't understand the ladders, don't play go.

The poor player plays the opponent's game for him.

If you have lost four corners, resign.

Pon-nuki is worth thirty points.

One point in the center is worth ten in the corner.

To reduce an opponent's large prospective territory, strike at the shoulder.

If you plan to live inside enemy territory, play directly against his stones.

Knight's moves win running battles.

When your opponent has two weak groups, attack them both at once.

These proverbs appear on the inside covers of Fairbarn's Introduction to Go:

The enemy's vital point is your own.

Add one stone, then sacrifice both.

The monkey jump is worth nine points.

The saki bottle shape is negative.

There is no territory in the centre.

2-1 is the vital point in the corner.

Fill in a semiai from the outside.

Groups mustn't float.

The strong player plays straight, the weak diagonally.



If you lose by one point, take a rest.

Win the early ko to win the game.

If you lose all four corners, resign.

Attatch to the strongest stone in a pincer.

Keep away from thickness.

Five groups might live but the sixth will die.

Win the stones, lose the game.

Don't make territory near thickness.

Sacrifice small to take large.

Corner, side, centre.

Save the ko till last.

Extend one hand from the cross-cut.

Good moves and bad moves are bedfellows.

Don't peep at cutting points.

Take the cutting stone on the second line.

The second line is the line of defeat.

The rectangular six is normally alive.

Play in the centre of a symmetrical formation.

Stop on second, extend on third.

The vital point of three stones is the centre.

If you don't know ladders, don't play go.

Strike at the waist of the knight's move.

Sacrifice and squeeze.

Empty triangles are bad.

Atari, atari is vulgar play.

Keep inessential ataris till the end.

Avoid the plate connection.



A meijin needs no joseki.

On the second line, 8 live, 6 die.

Big groups never die.

This third list overlaps in part both of the first two lists posted here recently.    It has 10 new ones that do not appear 
on either earlier list, and the grand total from all three is 77 proverbs (this is starting to sound like a basic set theory 
problem from sci.puzzles !).

From Go Proverbs by David Mitchell:

There is death in the hane.

Strange things happen at the one-two points.

The L group is dead.

Don't overlook the edge of the board.

If you don't know the ladders, don't play go.

There is damezumari at the bamboo joint.

Large groups never die.

Learn to play under the stones.

Eyes win semiais.

Don't make dangos.

Know the eye-stealing tesuji.

Connect with good shape.

Don't disturb symmetry.

Play at the centre of three stones.

From a cross-cut, extend.

At the head of two stones, play hane.

At the head of three stones, play hane.

The one-point jump is rarely bad.

The 3rd line is for territory, the 4th for influence.

Use the Knight's move to attack, the 1-point jump to defend.

Attack two weak groups simultaneously.



If there are six groups, one is dead.

Sacrifice for shape.

With only one group, you will win.  (extra one in text)

Each step in a ladder is worth 7 points.  (pro rule of thumb)

With less than 15 stones in danger, tenuki.  (new Russian proverb)



How To...

This section describes how to make use of the features of WINGO

Topics:
The Game of Go
Parts of the Screen
Menus
The Game Tree



Revision History

v 0.5 7/92 Allowed only playing of two player games, no loading / saving

v 0.9 2/93 Incorporated Smart-Go format files with limited features (only read main variation and moves)

v 1.0 7/93 Extended support for Smart-Go format to allow viewing / editing of variations, letters, marks, etc.
First public release. 



Future Enhancements

Numbering on stones,

Support for Ishi Standard file format,

Printing of board diagrams as well as output    in Postscript(tm) and Windows .BMP formats,

Better game tree editing,

Scoring,

Computer playing
As WINGO is written in C++ and is essentially modular, I am planning a future release of WINGO in which custom 
player modules can be linked in with the rest of the program. In this way, the graphical interface and game tree 
handling routines in WINGO would be made availble to any playing routine that could be called from Borland C++. 
Also, this could provide a simple environment in which computer go programs could compete.
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Menus

WINGO conforms with GUI conventions of most MS-Windows programs.

File Menu

To load or save a game, choose Load or Save.

To leave the program, choose Exit from the File menu or Close from the system menu in the top left hand corner of 
the main window.

The Save Short option determines whether files are saved in the longer, more easily read format or in the shorter 
space saving format. The default is the short format.

The Edit Menu

Currently only allows for thadding and deleting of variations. To add a variation (child) to the current node, choose 
Add Variation. To delete one of the variations from the current node, select the variation in the Variation Window. 
Then choose Delete Variation from the Edit Menu. The variation and all nodes it contains will be removed from the 
Game Tree.

The Move Menu

This menu allows you to move around the game tree. Up, Down, and Top are self-explanatory. 

The End command goes to the end of the current variation. 

The Forward and Back commands traverse the game tree in such a way that all nodes are visited. In some situations, 
variations may be confusing if viewed in this order.

The Add Menu

This menu allows for the creation of diagrams and provides tools to aid in commenting on a board position.
All of the commands toggle, e.g. if you choose Add Marks and click on the board at a position that is already 
marked, the mark will be turned off.

Add Black Stones and Add White Stones allow a number of black or white stones to be placed consecutively on the 
board. No checking is done on the validity of these moves, and stones may added so as to replace stones on the 
board.

Add Empty Spaces allows for stones to be removed from the board.

The preceding commands are done by WINGO in a certain order: first, stones are removed, then black stones are 
added, then white stones are added. So if you add an empty space on the same intersection as you add a white stone, 
the white stone will be displayed.

To avoid ambiguity (and a possible bug), I would advise that you give no intersection more than one of the 
preceding    three properties on any given node.

Add Marks allows for spaces to be marked by red circles for the purposes of comments (e.g. "the marked black 



stones are dead"). It is overridden by:

Add Letters, which allows for intersections on the board to be labelled by a letter, starting with 'a' and the increasing.

Options Menu

This menu currently only provides access to the Game Info screen, where information about the game can be viewed
/ entered.



Parts of the Screen

The playing window of Go for Windows looks something like the following:

The comment window shows the comment connected to the most recent move. To edit the comment, click in the 
comment window.

The variations window shows the varaitions below the current node, with node names (if they have names). To go 
to a variation, double click on one of the lines in the Variation window.

The white box in the middle on the right is the node name box. Each node can have a name associated with it, and 
this name will be dislpayed in the box. To edit the name, click in the box.

The Board

During the course of play, the cursor will be either:

 (when it is Black's turn) or

 (when it is White's turn). 
To place a stone, click on the board where you want the stone to go. If you release the mouse button without moving
the mouse, a stone will be played on the board (provided that the position you selected is a legal move).

If you set up a diagram by choosing options from the Add Menu, the cursor will be one of:

 when adding black stones,

 when adding white stones,

  when adding empty spaces (i.e. clearing stones from the board).

 when adding marks, or

 when adding letters.



The Game Tree

One of the important features of WINGO is that central to the program is the Game Tree:

The nodes on the game tree each contains a number of properties. These properties may include the location of a 
move, a comment, etc. Each may also have a number of children nodes. Children nodes represent variations. Thus 
Add Variation from the Edit menu corresponds to adding a new child node to the current node. Another letter is then 
added to the Variations window to represent this node.

When a stone is played on the board in the course a game, WINGO expects the current node to be at the bottom of 
the game tree (i.e. that the current node has no children). If this is not the case, a warning will be issued:

If you click on "Yes", WINGO will delete all of the nodes below the current node and then add the move.

Changes to the game tree, such as comments, node names, marks and letters are made to the current node, which 
generally corresponds to the last move played. If no move has been played or a new variation has been added, such 
changes will be connected to the next move made. If you want to have a comment or diagram not connected to a 
move, you will need to add a Variation (from the Edit Menu)    then move to the variation (by double clicking on the 
last line in the Variation Window). Make the changes (e.g. type the comment in the Comment window), then add 
another variation and move to that variation before playing more stones.




